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CHAPTER 1

Welcome
Welcome to the Doc-To-Help Getting Started Tutorial. This self-paced tutorial will show you how to
use Doc-To-Help's basic features. During this tutorial, you will create a project about San Diego
using two existing Microsoft Word documents. You will add elements to the project, as well as build
PDF and NetHelp outputs from it.

As you are working through the Getting Started Tutorial, you may want to learn more about the fea-
tures discussed. If so, please refer to the Dynamic Help window, or click the Help button to open
the online Help.
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CHAPTER 2

Creating a Project
Creating a new project is quick and easy with the New Project Wizard.

1. In Word, select File > Doc-To-Help.

2. Select New Project. The New Project Wizard opens.

3. Name your project San Diego. Doc-To-Help saves the project in a folder with the same
name within the default My Doc-To-Help Projects folder. This makes it easy to keep your pro-
jects organized.
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4. Click Next.

The next page gives you the opportunity to import settings from an existing project. Since we
are going to work through a few settings later, we will skip this page.

5. Click Next.

On the next page you can select the default language for your project. The initial setting may
be different, depending on your computer setup (e.g., it might be English, German, French, or
something else), but you can choose another language from the drop-down list. Doc-To-Help
chooses the correct character set based on the language chosen.

6. Click Next.

On the next page you can use the wizard to select the template (.dotx) file for your Microsoft®

Word source documents.

Doc-To-Help uses templates to determine how content will look and behave in both your
source documents (when authoring in Word) and your final targets (online and print-based out-
puts).

Doc-To-Help automatically chooses your target template based on your selections.

7. If it is not already selected, choose Normal 8.5" x 11" Template (no left indent) and click Next.
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8. On the next page, you can select your default target. You can generate any of these targets
from your project at any time, but the default chosen here will be the one displayed when you
open your project.

Choose NetHelp (Doc-To-Help's browser-based uncompiled HTML format). This output can
be used on the web, within a software application, or on a file server.
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9. Click Next.

On the next page you can select a type of for your first document. We are going to use an
existing document to start our project.

10. Choose Import existing files and click Next.

NOTE: Doc-To-Help will launch an import wizard after the project is created to make
the import process simple.
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11. Review the new project information and click Finish.
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CHAPTER 3

Importing a Document
Our project is created, but since we chose the "Import existing files" option, the Document Import
Wizard opens.

1. Choose Local to import documents stored on your computer and then click Next.

2. Click Add file(s). A dialog automatically opens to C:\Users\[username]\Documents\My Doc-
To-Help Projects.
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3. Navigate to Samples > All About San Diego Sample > Documents, and select SanDiegoQuick-
Tour.doc.

4. Click Open. The document displays in the wizard.
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NOTE: Word source documents are stored in the Documents folder of the project. In
this example, Doc-To-Help will automatically copy the SanDiegoQuickTour.doc file to
C:\Users\[username]\Documents\My Doc-To-Help Projects\San Diego\Documents.

5. Click Import. The document is imported.

6. Click Close. The imported document displays in the Documents window pane of the Doc-To-
Help Project panel in Word. The first imported document listed in the Documents pane will
open by default.
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7. Select the Doc-To-Help ribbon. Notice that this ribbon lets you create links, add index entries,
and more. This information is used to create the final outputs.

Also take a minute to look at the Doc-To-Help Project panel. (The panel should already be
open, but if it isn’t, select the Project ribbon and click Project Panel.)

From here, you can open other project documents, quickly jump to topics in the project, and
create links to project elements such as index keywords, variables, and topics.

Now it's time to learn more about specific Doc-To-Help features. Although the following lessons are
divided to make them more manageable, it is recommended that you do them in order so that you
can see the progression of your project.
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CHAPTER 4

Building and Examining a
Target
So far, we have done very little, but we have given Doc-To-Help enough to work with. If we build right
now, we can take a look at what Doc-To-Help will do out-of-the-box. But first, let’s take a quick look
at our Word document. If it is not already open, from the Documents pane double-click the
SanDiegoQuickTour.doc file to open it.

It is structured like this:

n Heading 1 All About San Diego

n Heading 1 San Diego Attractions

l Heading 2 Balboa Park

l Heading 2 San Diego Zoo

l Heading 2 Petco Park

n Heading 1 San Diego Colleges and Universities

Your Doc-To-Help project will use this structure to create topics, the table of contents (TOC), and
automatic links.
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Select the Target ribbon, and notice that the left section of this ribbon is named after the choice of
your active target. This is initially set to NetHelp by default.
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1. On the Target ribbon, click the face of the Build button (not the down arrow).

2. The default NetHelp target generates. The Doc-To-Help Build window pane displays at the bot-
tom while the build is in progress.

Once the build is completed, Doc-To-Help prompts you to view the target. Click Yes.
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WARNING: Your browser’s security settings may block display of NetHelp. If so, click
Allow blocked content to view your target.

The TOC structure is based on the heading styles. Since Balboa Park, San Diego Zoo, and
Petco Park used Heading 2 styles under the Heading 1 of San Diego Attractions, they were
converted to subtopics.

3. In the TOC of the NetHelp output, click the San Diego Attractions topic. The topic has three
automatic subtopic links—Balboa Park, San Diego Zoo, and Petco Park—which were created
by Doc-To-Help based on the document structure. We will learn later how to add custom sub-
topics, but these are created automatically.
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4. In Word, click X in the upper-right corner of the Doc-To-Help Build window pane to close it.
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5. In the Doc-To-Help Project panel (Doc-To-Help > Project Panel), click the Contents accordion
bar.
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The TOC is displayed. It looks exactly like the TOC in the NetHelp output.
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In the Doc-To-Help ribbon, you can use the Add, Rename, and Delete options to edit the
names of your topics and modify the TOC. Once a change is made in the TOC, the word "Cus-
tomized" displays in the top-right of the Contents pane to indicate the TOC has been modified.

However, the automatically generated TOC uses a logical structure and is ready to be used
for your project, so we will leave it as is.
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6. On the Project ribbon, click Topics Panel.

The Topics window pane opens, showing the topics that were automatically created when
you generated the target. Each Heading 1 and Heading 2 style starts a separate topic in the
project. This makes it possible to create links between topics, and more.

Now that we have seen our baseline, let's add more to this project.
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CHAPTER 5

Inserting an Image
We are going to add an image to our source document, but first we must copy an existing graphic
into our project.

1. Using Windows Explorer, navigate to C:\Users\[username]\Documents\My Doc-To-Help Pro-
jects\Samples\All About San Diego Sample\Media.

2. Copy the SanDiego.jpg file.

3. Paste it into C:\Users\[username]\Documents\My Doc-To-Help Projects\SanDiego\Media.
Although you can use images from any folder, it is a best practice to store all of your images in
your project's Media folder.

4. Now we are ready to insert our image in the SanDiegoQuickTour.doc file. In Word, the All
About San Diego topic should already be displayed, since it was the last topic opened. After
the third paragraph (which begins with "Although it is located along the Pacific Ocean…"),
press Enter to add a new empty paragraph.

5. Select the Insert ribbon, and click Pictures. The Insert Picture dialog opens.

6. Navigate to the Media folder in your project (C:\Users\[username]\Documents\My Doc-To-
Help Projects\SanDiego\Media), choose SanDiego.jpg, and click the down arrow next to the
Insert button.

7. Choose Insert and Link. This is the recommended option for Doc-To-Help projects.
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The image is now inserted in the document.
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By the way, you can also quickly add multimedia (video or audio) to a document using the Mul-
timedia button on the Doc-To-Help ribbon.
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CHAPTER 6

Applying a Style
Doc-To-Help uses styles to markup your source documents. In Word, these styles are stored in a
template (.dotx) file. The source styles are interpreted by the target template to make the target
files look and behave the way you desire. For example, as you saw earlier, Heading 1 and Heading 2
styles will determine your project's topic list, the structure of your table of contents, and the auto-
matic subtopic links.

In this section, you will learn how to apply a Doc-To-Help style in Word. Although the style we will
apply in this exercise is one that only controls formatting, later we will apply styles that control both
formatting and behavior (see "Adding Glossary Entries" on page 60).

In Microsoft Word, you can apply styles quickly using the Home and Doc-To-Help ribbons, as well as
the Styles window pane.
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Let's add some new text and apply a style to the file SanDiegoQuickTour.doc.

1. After the image you inserted and the text "Here's what you can expect when you come to San
Diego," add the following two paragraphs:

The coast has cool, breezy weather, with little change in the tem-
perature from day to day.

Inland valleys are warmer and more humid than the coast, with cool
nights.
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2. Select the two new paragraphs, and on the Home ribbon, in the Styles group, click in the
bottom-right corner. The Styles window opens.
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3. Choose the C1H Bullet style. The style is applied.
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CHAPTER 7

Creating a Topic Link
You can easily create links to other topics, as well as bookmarks, link tags, keywords, groups, and
glossary entries.

1. Scroll up to the first paragraph in the All About San Diego topic, and select the word attrac-
tions.
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2. In the Doc-To-Help ribbon, click Link. The Link dialog opens.

NOTE: You can also use the Link dialog to create links to keywords (i.e., index
entries), groups, bookmarks, link tags, and glossary entries.

3. From the Link type drop-down, make sure Topic title is selected.

CHAPTER 7  32



TIP: Notice in the Options area of the dialog, you can select the "Show as button"
check box. This changes your link text to a button. Selecting the "Popup" check box in
the Link options area makes the topic display in a popup window. By the way, linking
will work in the PDF version of your manual target, as well as in your online outputs.
You can select a Grid or Tree view of the "link to" topics. Click the button to the right
to choose.
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4. In the Topics area, expand SanDiegoQuickTour.doc and from the list choose San Diego Attrac-
tions.

NOTE: Remember that Doc-To-Help does not create your topics until you first build
the output. You already generated output in a previous step (see "Building and Examin-
ing a Target" on page 15); therefore, the San Diego Attractions topic was available for
you to select.
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5. Click OK. This creates a topic link from the word "attractions" to the topic about San Diego
attractions in the online output when it is built.

NOTE: If you have hidden text turned on in your document, you will see the inform-
ation for this link tag displayed. As you can see, the tag is the topic you selected (San
Diego Attractions).

If you would like to hide hidden text, choose File > Options, and on the left, click Dis-
play. Clear the Hidden Text check box on the right.

TIP: You can create links to documents, topics, variables, index keywords, and groups by
simply dragging and dropping items from the Doc-To-Help Project window pane to the loc-
ation where you want to create a link.
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CHAPTER 8

Creating Inline Text
Inline text is expanding, drop-down, or popup text. It is a great way to add dynamic information to
your online output.

1. Go to the second paragraph in the All About San Diego topic and select the phrase America's
Finest City.
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2. In the Doc-To-Help ribbon, click Inline Text.

3. Choose Expand text inline, and in the text box, add the following:

Stay classy, San Diego!

4. Click OK.

Doc-To-Help might inform you that this is an invisible style. This means the inline text we
added will be invisible in this document (our source document), as well as in our target, until
clicked. Since that is okay to keep the inline text invisible in the source document for this
tutorial, click No to close the message if it appears.

When we build the target, "America's Finest City" will be a hyperlink that displays "Stay classy,
San Diego!" when clicked.

5. Save the document.
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CHAPTER 9

Creating an Index Entry
You can add index keywords (also known as K-Links) in your Doc-To-Help project.

1. In the All About San Diego topic, go to the third paragraph and select the words Pacific Ocean.
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2. In the Doc-To-Help ribbon, click Keyword.

3. The Keyword dialog shows "Pacific Ocean" as the selected text. It also indicates in the Key-
word field that the "Keyword (is) defined by Text". Click OK to add "Pacific Ocean" to your
index.

NOTE: "Pacific Ocean" appears in your source document with a different text color,
but that color change will not be visible in your final output. It is there in your source
so that you know it is an index keyword.

You can add also keywords and secondary keywords from this dialog. See "Adding
Items to the Index and Creating Groups" on page 67.
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4. Save the document.

5. In the Target ribbon, click Build.

After the build is complete, you can view the output in your browser.

In the "All About San Diego" topic, you will see that:

n The project name appears in the header as "San Diego" — the name we gave the Doc-
To-Help project in the wizard. We will change that in the next lesson.

n The word "attractions" is a hyperlink that opens the "San Diego Attractions" topic.

n "America's Finest City" is a hyperlink that displays expanded text (Stay classy, San
Diego!) when clicked.

n "Pacific Ocean" is not highlighted in the target (but it is included in the Index; click the
Index button below the TOC to see it).

n The first two bullet points (about the "The coast…" and "Inland valleys…") are properly
formatted.
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6. In the Doc-To-Help Project window pane, click Index and Groups. Notice that "Pacific Ocean"
appears in the list of keywords.

NOTE: You can also create keywords from the Index and Groups view. Also, you can
drag and drop selected keywords in your document into this view.

For more information, see the online Help.
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CHAPTER 10

Defining Targets
By default, our sample has eight default targets. But we can rename our targets and delete the ones
we do not need.

1. In the Target ribbon, click Target Properties.

The Help Targets dialog opens. Since NetHelp is our default target, that target is selected in
the dialog.
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2. On the right-side of the dialog, change the Name field from NetHelp to All About San
Diego NetHelp.

After you click off the field, the name of the target (on the left side of the dialog) changes to
match the name you entered.
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3. In the Caption field, enter All About San Diego. This changes the name displayed in the
browser from "San Diego" to the name we prefer.

4. In the list of targets on the left side of the dialog, click the HTML Help (compiled HTML Help)
target.

5. Change the Name field to All About San Diego HTML Help.

6. Select the Manual target and change the following fields:

a. Set the Name field to All About San Diego Manual.

b. Set the Title field to All About San Diego.

c.  Set the Supertitle field to Visitors Guide.

d. Set "By" line field to San Diego Productions.

7. Since we do not need to create Eclipse Help, EPUB, Help 2.0, JavaHelp, or MS Help Viewer for
this project, select those targets in the target list on the left side of the dialog and click the
Remove Target button for each. You can always add them back later.
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NOTE: If you remove targets from your project in the Help Targets dialog , you will not
see these targets when viewing Target drop-downs in Word (e.g., in the Contents win-
dow pane or in the Doc-To-Help Build panel). For more information, see the online
Help.

8. Click OK to close the dialog.

9. In the Target ribbon, click Active Target. The newly named targets are displayed, instead of
the defaults.

10. If you would like, save your document. Select each target and then build and view its output.
You will see the changes we made displayed in each target.

NOTE: You can have several versions of the same target. For example, you could
have multiple NetHelp targets directed at different audiences. Just add them using
the Add New Target button in the Help Targets dialog.
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CHAPTER 11

Creating Custom Topic
Relations
When you open your NetHelp output and click the San Diego Attractions topic in the table of con-
tents (TOC), you will notice that at the bottom of the topic, there is a section that begins with "More:"
and is followed by links to "Balboa Park," "San Diego Zoo," and "Petco Park." These are called "sub-
topic links" and they are created automatically by Doc-To-Help, based on the structure of your doc-
ument.

The San Diego Attractions topic has a Heading 1 style, and Balboa Park, San Diego Zoo, and Petco
Park have Heading 2 styles immediately following it. If there were phrases using Heading 3 styles
under Balboa Park, they would appear as subtopic links in that topic.
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HOW TO CHANGE THE WORD USED FOR SUBTOPIC LINKS FOR YOUR TARGET

1. In the Target ribbon, click Target Properties.

2. On the left side of the dialog, select All About San Diego NetHelp.

3. Scroll down to the Related links section, and change the text in the Label field to See Also.

4. Click OK.The text in this field will now be used to denote subtopic links in your project.
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HOW TO CHANGE THE WORD USED FOR SUBTOPIC LINKS ON INDIVIDUAL TOPICS

1. At the bottom of the Doc-To-Help Project window pane, click the Related Topics accordion
bar.
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2. Select the San Diego Colleges and Universities topic.

3. In the Doc-To-Help ribbon, click Topic Properties.
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4. In the D2HML Topic Properties dialog, click in the Related links label field, and enter More
Schools.

5. Click OK. The text in that field will now be used to indicate subtopic links in this specific topic
(if subtopics are added under it in the future).
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HOW TO ADD CUSTOM TOPIC RELATIONS IN THE RELATED TOPICS WINDOW

1. At the bottom of the Doc-To-Help Project window pane, click the Related Topics accordion
bar.

2. Select San Diego Attractions. Balboa Park, San Diego Zoo, and Petco Park are automatically
displayed at the bottom of the Related Topics view.
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3. In the Project ribbon, click Topics Panel.

4. From the Topics window pane, select San Diego Colleges and Universities and drag it into the
lower Related Topics area. It is now related, and it is marked as a "Custom related topic."
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5. Save the document, and in the Target ribbon, click Rebuild.

In the output, look at the new list of subtopic links for San Diego Attractions. San Diego Colleges and
Universities has been added to the list. Also, notice the “See Also” text that we specified earlier.

TIP: If you prefer that the subtopic links are not displayed in a specific topic, choose that
topic in the Topics window pane, click the Properties button, and select Hide subtopic links.

As you can see, automatic and custom topic relations give you a lot of options for navigating your
output. For example, you can create custom links to other topics that users may find useful—and
the links are very clear and noticeable. You can create custom links from subtopics to their "parent"
topics—this directs users back to the parent, which may lead them to other topics of interest. Relat-
ing topics helps to eliminate information "dead ends"—the user has links to other information and
could be saved the trouble of using search, or checking the TOC or index.
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CHAPTER 12

Adding a Document
On occasion, you might need to add an existing document to your project after you have created it,
so let’s do that now.

We will also take this opportunity to add a glossary to our project.

1. At the bottom of the Doc-To-Help Project window pane, select the Documents accordion bar.

2. Click the Add Existing Documents button .

The Document Import Wizard opens.
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3. Follow the same steps we used when importing the SanDiegoQuickTour.doc (see "Importing a
Document" on page 11). However, this time, from C:\Users\[username]\Documents\My Doc-
To-Help Projects\Samples\All About San Diego Sample\Documents, choose Glossary.doc.

We could have imported this originally, but now you can see how easy it is to do after you have
already created your project.
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4. After the import is complete, the new document appears in the Documents window pane.

5. Since a glossary is a special type of document in Doc-To-Help, right-click it and from the con-
text menu, choose Glossary. This document is now flagged as a glossary with a special icon.
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6. Double-click Glossary.doc to open it. You will see two glossary entries in this document:
Aztecs and Old Town. If you put your cursor in either heading, you will notice that they are
formatted with the Glossary Heading style. This style has a special behavior in online outputs.

NOTE: Now that you have multiple documents in this project, you can double-click
either document in the Documents window pane to quickly switch between them.

7. Save the document, and in the Target ribbon click Build.

8. When the build is completed, view the output. Notice that Glossary has been added to the
table of contents, and the word "Aztecs" found in topics is now a hyperlink. When you click on
it, the glossary entry is displayed as a pop-up window.
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NOTE: Your Doc-To-Help project automatically creates links from topic text to identical
glossary entries, but only for the first instance of the word in each topic. This can be turned
off if you like, but it is a great way to give your readers access to useful definitions that they
might normally miss, with no extra work on your part. If you would like to create a manual
link to a glossary entry, simply create a link using the Glossary Link Type in the Link dialog.
See "Creating a Topic Link" on page 31.
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CHAPTER 13

Adding Glossary Entries
It is easy to add entries to your glossary, and you do not need to worry about alphabetizing them
because Doc-To-Help does it for you.

1. At the bottom of the Doc-To-Help Project window pane, select the Documents accordion bar.

2. Double-click Glossary.doc to open it. This document contains two entries.
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3. After the first two entries, add the following text:

Santa Ana Winds

Strong, extremely dry down-slope winds that originate inland and
affect coastal Southern California.

Now, we need to apply styles to the new entry. These styles not only control the look of the
entries, but also the behavior.

4. Highlight the words Santa Ana Winds.
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5. Using the Styles window pane, set the style to Glossary Heading. See "Applying a Style" on
page 27.
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6. Select the definition below it and set the style to C1H Popup Topic Text.

NOTE: Fortunately, our glossary terms are already in alphabetical order. If they were
not, you could fix that. To do this, select the Doc-To-Help ribbon, and in the Glossary
section click Sort. The glossary is alphabetized.
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7. Save your document and build the target.

"Santa Ana Winds" is now part of the glossary; it is also listed in the Topics window pane.
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CHAPTER 14

Creating a Customized Table of
Contents
As you have already seen, Doc-To-Help automatically creates a table of contents (TOC) for you
based on the structure of your documents. But you can customize the TOC if you wish.

1. At the bottom of the Doc-To-Help Project window pane, select the Contents accordion bar.

NOTE: If you select an item in the TOC and click Remove Topic to delete it, or drag a
topic from the Topics window pane into the Contents view to add it, the TOC is
flagged as "Customized." Changing the name of an item in the TOC (using the
Rename button) also customizes it.
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To set the TOC to be exclusively used for the target selected, click the Target-Specific Table
of Contents button.

To revert back to the original TOC, which is based on the document structure, click the
Rebuild Table of Contents button.

2. For this tutorial, click the Rebuild Table of Contents button. This will build the customized TOC
you set.
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CHAPTER 15

Adding Items to the Index and
Creating Groups
There is already one item in our index, which we added directly from one of our documents. We can
also add items using the Index and Groups window view and from the Topics window pane.

1. At the bottom of the Doc-To-Help Project window pane, select the Index and Groups accor-
dion bar.

2. If it isn’t already selected, click the Keywords button.

3. Click the Add New Keyword button.

4. Name the new keyword Education and press Enter.
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5. From the Topics window pane, select the topic San Diego Colleges and Universities and drag
it into the lower Keywords view. You can link multiple topics to a single keyword; just drag
them into the lower window view.
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6. Click the Groups button.

NOTE: You can create topic groups using this same window view. Topic groups are
collections of topics you can create links to. When the user clicks the link, the topics
in the group appear in a popup window or dialog.

7. Click the Add New Group button and name the new group tourism.
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8. In the Topics window pane, select the topics Balboa Park, San Diego Zoo, and Petco Park and
drag them into the lower Groups view.

These topics are now in a group named "tourism" and you can create a link to them using the
Link dialog.

9. At the bottom of the Doc-To-Help Project window pane, select the Documents accordion bar.

10. Double-click SanDiegoQuickTour.doc to open the document if it is not already open .

11. In the second paragraph, select the word tourism.
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12. In the Doc-To-Help ribbon, click Link.

13. From the Link type drop-down, choose Group.
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14. Select the tourism check box and click OK.
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15. Save the document.

16. Build the target and view the output.

Notice that "tourism" is a hyperlink. When you click it, a menu with all of the topics in that
group displays. Select any one of the menu items, and the topic opens.

We hope you enjoyed the Doc-To-Help Getting Started Tutorial! Feel free to use this project to test
drive Doc-To-Help further.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

On the Doc-To-Help Start Page, click the PDF Guides icon to access them.

Context-sensitive Help Guide Shortcuts Cheat Sheet

Design Guide Targets Guide

Documents, Templates, and Content Guide Touring the Workspace Guide

Getting Started Guide Upgrading Old Projects Guide

Getting Started Tutorial What's New Guide

Project Management Guide
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